Welcome to Banner Training

Be sure to:

♩ Sign-in
♩ Make a name card
♩ Set cell phones to “Quiet” mode or off
♩ If you must leave early, please do so as discretely as possible
♩ Avoid side conversation during presentation
♩* Participate 😊 !!

*Participate with enthusiasm and engagement.
Banner Student Overview
Session Organization

This session was designed to be instructor led and follows traditional classroom activities you may have been previously exposed to. In this course the instructor will present to you information about how to use Banner Student and – at times -- ask that you complete activities/exercises in this manual. During this course you will find that following along in the manual will help you to complete this course successfully.

Please avoid trying to follow the instructor using your computer until asked to do so.

<table>
<thead>
<tr>
<th>Session Manual Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Discussion</strong>: Look, listen, interact, and learn! These pages will focus on concepts, highlight certain topics/items, or even ask for your feedback.</td>
</tr>
<tr>
<td><strong>Procedure</strong>: Look, listen. That’s basically it…watch the demonstration and follow along in your manual.</td>
</tr>
<tr>
<td><strong>On Your Own Activity</strong>: The instructor talked about it, you’ve seen it…now perform the task following the steps provided.</td>
</tr>
<tr>
<td><strong>Exercise</strong>: Test your knowledge and skills! Complete the exercise per the instructions. If you need help…just ask! We want you to succeed.</td>
</tr>
</tbody>
</table>
Banner Student - Overview

Lesson 1: An Introduction to Banner Student
Banner, Banner Student and Wayne State University

Lesson 2: Getting Started in Banner Student
Topic 1: Log On To Banner Student
Topic 2: Parts of the Interface
Topic 3: Form Parts and Layout
Topic 4: Forms and Form Windows
- Hyperlinks & the Options Menu
- Form Windows
Topic 5: Elements of a Form
Topic 6: Using the Mouse & Keyboard

Lesson 3: Accessing Banner Student Forms
Topic 1: Primary Form types used in Banner Student
Topic 2: How to read Form names
Topic 3: How to access Banner Student Forms using:
  – Main Menu
  – Direct Access
  – Last 10 Forms list on the File menu
Topic 4: Using buttons inside of a form

Lesson 4: Banner Student Inquiries
Topic 1: Query basics, wildcards
Topic 2: How to perform a query using an inquiry form
Topic 3: How to perform a query using an application form
Topic 4: How to perform a query using a form field

Lesson 5: An Introduction to General Person
Topic 1: An Overview of the General Person Module
Topic 2: Verification of a Student in Banner Student
Topic 3: Access Identification Information
Topic 4: Querying Additional Information in Banner Student

Lesson 6: Features In Banner Student
Topic 1: Using the calculator and calendar
Topic 2: Customizing Banner preferences
  - Form display options
Topic 3: Changing the Banner password

Appendix 1: Banner Web Access
Topic 1: System requirements
Topic 2: Browser plug-in
Topic 3: Required setting change

Appendix 2: Session Key Points
Topic 1: Toolbar buttons reference
Topic 2: Keyboard shortcuts
Topic 3: Form names
Topic 4: Common inquiry forms

Session Agenda
In Banner Student Overview, you will learn how to:

• Navigate in Banner Student
• Locate Forms you need
  – Navigate within a form
  – Add/Edit form data
• Execute basic Banner Student inquiries
• Sign on to Banner Student to begin your work.

Upon completion of this class you will be an important part of the University-wide Student Information System network.
Intentionally Blank

NOT oatmeal raisin!
Lesson 1: An Introduction to Banner Student
Lesson 1: Introduction to Banner Student

Introduction Overview

Assuming the Banner Student Information System (Banner Student) is new to you, it is critical that you understand its role and function at WSU, the information systems that interface with it, and its major features.

By the end of this short discussion you will have identified the following:

1. The functions and major features of Banner Student
2. Which other information systems feed Banner Student
Introduction: The Function of Banner Student

Banner Student is one product of the Banner suite of products. These products are integrated into a common database so that information can be shared across different systems that administer the numerous functions of the University. Currently, Alumni/Development and FMS are the only systems “live” here at WSU, but look for more on the way.

As is, the Banner system will offer enhanced user convenience and flexibility. This will be even more notable as further Banner programs are implemented.

The Banner Student supports the full range of functions necessary for student administration, including: class schedule administration, admissions, academic history, degree audit reporting, registration, academic status, and holds.
Banner Student is a University-wide system which enables you to track, maintain and report your department’s important student related administration and data processing.

Let’s begin by taking an overall look at Banner Student and its connection to other operations here at WSU, as illustrated with the graphic on the right.

With this common database, data need only be entered once!
Discussion: Major Features of Banner Student

Major Features of Banner Student

Banner Student is an online product which utilizes the Oracle Relational Database Management System. At Wayne State University, Banner Student is integrated with other systems such as Financial Management, Alumni/Development and Human Resources. This capability enables you to access information that already exists on any of the other systems.

Banner Student includes the following major features:

**Web Enabled functionality** — Banner 5.x provides many features and functions which are accessible via standard internet connections. A primary benefit is an improved access and performance experience.

**Comprehensive Reporting** — You can access numerous standard hard copy reports and online inquiry forms.

**User Friendly Design** — Banner looks and operates like many of the typical “windows” applications you’re already using! Menus and the mouse are available to Banner Student infrequent users.

**Online Data Entry** — When you enter data in a field, the system checks it for **accuracy** (that is, the system subjects the data to the appropriate validation test) before the cursor continues to the next field for an update. If the system finds an error, an appropriate error message displays and no database update occurs. After you correct the error, the cursor moves to the next field.

**Easy Data Entry and Update** — Banner forms allows you to enter, maintain and update data and related information with ease.
Ever have one of those days??
Lesson 2: Getting Started with Banner Student
Lesson Overview

The Banner interface is designed as a Graphical User Interface (GUI). A GUI uses pictures to represent features and functions of Banner, thus providing for simple ‘point-and-click’ control of the program.

This lesson will introduce you to the basic layout of Banner, and the names and functions of key elements of the program interface.

Before you can begin to navigate within Banner Student, you will need to differentiate between “areas” of the software. Being able to differentiate between “areas” and their functions will help you in the lessons that follow – and ultimately ensure your success in using Banner Student effectively.

Lesson Agenda

Topic 1: Log On To Banner Student
Topic 2: Parts of the Interface
Topic 3: Form Parts and Layout
Topic 4: Forms and Form Windows
  - Hyperlinks & the Options Menu
  - Form Windows
Topic 5: Elements of a Form
Topic 6: Using the Mouse & Keyboard
To begin working in Banner Student, you must first log on to Banner.

You will need three things in order to do this back at your desk:
1. A WSU Access ID
2. User password
3. Internet access

For an in-depth review of Banner 5/Web Access system requirements and setup, please refer to the information in Appendix 1, Banner Web Access.
Procedure: Log On To Banner Student

Procedure:
1) Launch Internet Explorer
2) Enter banner.wayne.edu in the address field - click ‘go’
3) Type your **username**
4) Type your **password**
5) Click the **Connect** button

Banner will open
Topic 2: Parts of the Interface

This lesson topic will introduce you to the basic layout of Banner, and the names and functions of key elements of the program interface.

What you will learn in this topic:

Definition and functionality of the following:

- Menu bar
- Toolbars
- Hyperlinks
- Auto hint
- Status line

Items needed to complete this topic:

- Access to the Banner icon
- User name
- User password
Discussion: Parts of the Interface

Menu Bar: Contains the pull-down menus. Click to display menu options.

Toolbar: Contains standard buttons. Click on a button to perform a function.

Auto Hint: Primary point of informational messages from Banner.

Status Line: Contains information on the number of the current record & if the form is in query mode. Information shown here reflects position in a form, or Banner process you are in.
Discussion: Parts of the Interface

Features of the Menu Bar
The Banner menu bar, located at the top of every form, contains pull-down menus. This menu bar behaves like menu bars in other Windows-based applications.

Note: If a pull-down menu name is dimmed, the menu is disabled and cannot be accessed.
Procedure: Parts of the Interface

Features of the Menu Bar
Menu items are accessed by clicking on the menu item.

Here we have clicked on the File menu to display the available options/items to select from.

Note: A keyboard shortcut / alternative would be to press & hold the alt key down, and then press the underlined menu item letter.

These options are grayed-out and cannot be select until a form is loaded.
Discussion: Parts of the Interface

Toolbars & Buttons
The toolbar holds a set of buttons that offer quick access to the most commonly used functions in Banner. The toolbar appears directly under the menu bar.

NOTE: To access a toolbar button, single click the appropriate button. You can click on a button any time, except when you are in a dialog box, or alert box.
Discussion: Parts of the Interface

*Placeholder for buttons not used here at Wayne State.*

When you pause your mouse arrow over a toolbar button, a yellow bubble appears with text that describes the function of the button.
Discussion: Parts of the Interface

Auto Hint Line
The auto hint, at the bottom of a form window, may contain the following information for the field where the cursor is located:

• Brief field description
• Error and processing messages
• Keyboard equivalents, if you can access other blocks, windows, or forms from the field

NOTE: Remember to look at your auto hint frequently, especially if you have a problem entering data into a field.
Discussion: Parts of the Interface

**Status Line**
The *status line*, directly under the auto hint line, may contain one or more of the following messages:

- **Record n/n:**
  Shows the number of the current record followed by the total number of records in the current block. If there are more records that fit in the window, the total appears as a question mark (i.e., 3/?) until you scroll to the last record in the block. Once the last record is displayed, the total appears as a number (i.e., 1/8).

**Enter Query:**
Indicates the form is in query mode.

---

Lesson 2: Getting Started With Banner Student
Topic 2: Parts of the Interface
On Your Own Activity: Parts of the Interface

Identify these parts of the interface by filling in the blanks using the following terms:

1. Auto Hint
2. Toolbar
3. Menu Bar
4. Status Line
Data is entered into forms within Banner Student/Banner.

Each of these forms have common parts such as a title, window(s), key blocks, and fields.

Forms in Banner have many different parts to them. The more you know and understand the parts of the forms, the easier it will be for you to work in Banner Student.

What you will learn in this topic:

• Building blocks of a form:
  – Fields
  – Records
• The layout of an Banner Student form
• Information displayed on the title bar
• Types of blocks within an Banner Student forms
  – Key block
  – Other blocks
A field is sometimes called an item. Such is the case with names of the following Banner functions: Next Item, Previous Item, and Duplicate Item.

NOTE: Some text fields may appear to be a few characters longer than they actually are. For example, a field that allows up to sixty characters may look like it still has space after the sixtieth character. This is because each character uses a different amount of space.

Fields are areas on a form where you can enter, query, change, and display specific information. The following terms describe a field:

- **Enabled:** You can put the cursor in the field. Information in the field appears in black text.
- **Disabled:** You cannot put the cursor in the field. Information (if it exists) appears in gray text.
- **Enterable:** You can enter information in the field. The field is usually enabled. In certain situations, however, it may be disabled.
- **Display only:** You cannot enter information in the field.

Some fields are usually enabled but may be occasionally disabled. For example, in query mode sometimes you can’t query a field that is normally enabled, and sometimes you can query a field that is normally disabled. This is also true for enterable fields in a key block; once you leave the key block, all fields in the key block are disabled.
**Records** are sets of related fields. For example, a street, city, state, and ZIP code form one address record. Your telephone directory contains this information for everyone in your town, so there are numerous records in the phone book.

In Banner Student, if a block has multiple records, the records often appear in rows and columns. A horizontal scroll bar appears under the columns if all columns do not fit into the window at once. A vertical scroll bar appears on the right side of the rows if all rows don’t fit into the window at once. When you select a row, the entire record is highlighted to identify it as the current record.

The example shown to the right is an inquiry result with its multiple matching records.
**Title Bar:** Contains the full form & 7-character form names, version number of Banner Student and database name. Is very dynamic and changes as you move through various blocks or hyperlink to related forms.

**Key Block:** Contains key information regarding the record. May contain both data-enterable & non-data enterable fields.

**Other Block(s):** Contains additional information in data fields and/or related records.

---

**Discussion: Form Layout**

**Layout of an Banner Student Form**

- **Title**
  - Key Block - specific record identification information

- **Window**
  - **Block**
    - Field
    - Field
    - Field
    - Field

- **Block**
  - Field
  - Field
  - Field
  - Field

Lesson 2: Getting Started With Banner Student
Topic 3: Form Parts & Layout
The title bar shows the following information:

- Descriptive form name
- Seven-character form name
- Banner Student release number
- Database name

**Discussion: Title Bar**

Lesson 2: Getting Started With Banner Student
Topic 3: Form Parts & Layout
Discussion: Blocks

The first block on most forms contains key information. This Key block determines what is entered or displayed on the rest of the form. All information on the form refers to the Key block. (Some forms, especially validation forms and certain list forms, do not have a Key block.)

The Key block has at least one field and typically more. For example, a form that maintains financial information may have Key block fields for both a chart of accounts and a fiscal year.

The Key block stays on the form as subsequent blocks appear. Occasionally, another window may appear on top of the Key block if the window is unusually large or if the key block is not pertinent to the window contents.

When the cursor is in the key block, enterable fields in the key block are enabled. These same fields are disabled when the cursor leaves the key block.
A block is a section of a form or window that contains information related to the current record.

If a form or window contains more than one block, each block (except the key block) may be enclosed in a solid line box.

Most blocks have a title. Here are three exceptions:

- A key block does not have a title.
- If a form or window has only one block, the block does not have a title.
- If a form has a key block and only one other block, the second block does not have a title.
A form is an online document where you can enter and look up information in Banner Student. A form visually organizes information so it is easier to enter and read.

A form in Banner Student is similar to a paper document except information is entered once, and can then be used by other Banner Student forms.

What you will learn in this topic:

• Banner forms multiple parts and the use of hyperlinks
• Hyperlinks and the Options menu
• How windows are used to display forms
A typical form in Banner is broken down into multiple parts. When you first load and access a form, you are seeing only a *portion* of the entire form, with other parts brought into the main Banner workspace using *hyperlinks*. This approach allows Banner to present information on screen in a logical manner, while not attempting to squeeze every field within a record into too small a space.

This is a very similar design strategy as used with a typical internet website – when you arrive at a website’s “home page”, you will find hyperlinks that go to other web pages that contain information you are interested in. Far more efficient than having everything all on one very long page.

In Banner Student Banner, hyperlinks not only access other parts of the main form, but can also load separate, but *related* forms, that are involved in a Banner Student “procedure”.

---

*Lesson 2: Getting Started With Banner Student*

*Topic 4: Forms and Form Windows*
The active items on the **OPTIONS** menu on the menu bar are the “hyperlinks”. Some links take you to other blocks and windows *within* the current form. Other links take you *outside* the current form to other related forms.

The available hyperlinks change as the cursor location changes within a form.
Discussion: Form Windows

As other parts of a form are accessed through hyperlinks, many will appear in the main part of the Banner screen inside their own window – this is very similar to how Word displays multiple documents.

Note the example here of the main form window with 2 sub-windows open displaying other parts of the SPAIDEN form. Not all windows are the same size, so you may see parts of more than one window at the same time.

All other windows in the form have their own unique descriptive names as pieces of the main form.
Forms in Banner have many different and helpful elements to them. The more you know and understand the elements of the forms, the easier it will be for you to work in Banner Student.

What you will learn in this topic:

- The elements of a form
- The uses of buttons – Dialog & Alert boxes
- The uses of radio buttons
- The uses of checkboxes
- The uses of pull-down lists
- The uses of scroll bars
Discussion: Elements Of A Form - Continued

The following figures are various elements that appear on forms in Banner Student:

**Buttons**

**Pull-down list**

**Radio buttons**

**Checkboxes**

**Scrollbars**

Lesson 2: Getting Started With Banner Student
Topic 5: Overview – Elements of a Form
Buttons are small squares that contain an icon (picture). They represent one or more actions that can be performed for the associated file or record. For example, you can use iconic buttons to display a validation form for the field, copy a record or display a window for entering text.

**Response buttons** are shaded rectangles that appear in alert boxes and dialog boxes. An alert box has one response button. A dialog box has two or more response buttons. You must use these buttons to respond to the system before you can continue working.

**Note**: To perform a function associated with a button, simply single click the button.

This dialog box has three possible responses indicated by three response buttons.

This alert box only has one possible response indicated by the single button.
A dialog box is a window that appears when you must choose from two or more responses.

You **must** acknowledge a dialog box before you can do anything else on the form.

This dialog box has three possible responses.

---

You must click on a response before proceeding in Banner Student.
An alert box is a window that notifies you of a condition that may impact data. For example, see the graphic to the right.

You must acknowledge an alert box before you can do anything else on the form.

An alert box always has only one response.

You must click on a response before proceeding in Banner Student.
**Discussion: Radio Buttons**

Radio buttons are small circles used to select one of several options in a group. Each radio button represents a choice for the group. You can pick only one radio button in a group. When you select a radio button, the previously selected button is cleared and a smaller, black circle fills the newly selected button.

The ‘case sensitivity’ radio button is selected in the example below.

**NOTE:** The radio buttons in Banner behave like the radio buttons you’ve used in other Windows-based applications.

*Case Sensitive Query?

- No
- Yes*

- This radio button is not selected.
- This radio button is selected.*
Discussion: Checkboxes

Checkboxes are small boxes used to enable or disable features or options.

When an option is enabled, a check mark appears in the checkbox. When the option is disabled, the checkbox is empty. Clicking a checkbox will reverse the state of that option.

Checkboxes often represent yes/no conditions. For example, the first checkbox below indicates that it is active. The second checkbox indicates that it is not because there is no check mark. Sometimes checkboxes indicate navigation to other windows. The auto hint tells you when a checkbox is used for this type of navigation.

- **Accrue Leave:** selected / enabled
- **Civil Service:** not selected / disabled

This checkbox is selected / enabled
This checkbox is not selected / disabled
Discussion: Pull-down Lists

Pull-down lists are used to select a field value from a list of pre-defined values.

A down arrow in the right side of the field indicates the field has a pull-down list.

In Banner, pull-down lists behave just like they do in other Windows-based applications you’ve used.

Click here to open the pull-down list.

The list displays available options to choose from. Click the item of choice to activate it.
Discussion: Scroll Bars

Scroll bars are used to display *overflow* information when a form has more information than can be displayed at once.

Forms can have two kinds of scroll bars: vertical & horizontal. A *vertical* scroll bar, located directly to the right of the rows. A *horizontal* scroll bar, located directly under the window.

*NOTE:* The scroll bars in Banner behave like the scroll bars you’ve used in other Windows-based applications.

*Scroll bars* have arrows on each end and a scroll box in the middle. The position of the scroll box shows the relative position within the list being displayed.

A vertical scroll bar is shown in the example below.

- Click here to move up 1 line per click
- Click here to move up 1 page per click
- Click & drag here to move through the list
- Click here to move down 1 line per click
- Click here to move down 1 page per click
On Your Own Activity: Elements Of A Form

Match the form element in Column A to the correct name in Column B

Column A:

- Checkbox
- Field
- Button
- Pull-down list
- Radio buttons
- Scrollbars

Lesson 2: Getting Started With Banner Student
Topic 5: Activity – Elements of A Form
Like other software applications, Banner may be operated using keyboard commands and mouse activated commands.

**What you will learn in this topic:**

How to navigate through Banner using both keyboard commands and mouse activated commands
You can use **keyboard shortcuts** to quickly perform certain functions in Banner.

Here is a chart of the keyboard shortcuts available here at WSU.

**NOTE**: Data entry users will make good use of the following “permission-based” shortcuts:
- F4  Duplicate record
- F6  Insert record
- Shift/F6  Delete record
- F10  Save record

<table>
<thead>
<tr>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl F1</td>
<td>Display “Show Keys” window</td>
</tr>
<tr>
<td>F2</td>
<td>shift + F2</td>
</tr>
<tr>
<td>F3</td>
<td>shift + F3</td>
</tr>
<tr>
<td>F4</td>
<td>shift + F4</td>
</tr>
<tr>
<td>F5</td>
<td>shift + F5</td>
</tr>
<tr>
<td>F6</td>
<td>shift + F6</td>
</tr>
<tr>
<td>F7</td>
<td>shift + F7</td>
</tr>
<tr>
<td>F8</td>
<td>shift + F8</td>
</tr>
<tr>
<td>F9</td>
<td>List -Search</td>
</tr>
<tr>
<td>F10</td>
<td>Save changes</td>
</tr>
<tr>
<td>Ctrl + pg ↓</td>
<td>Next block</td>
</tr>
<tr>
<td>Ctrl + pg ↑</td>
<td>Previous block</td>
</tr>
<tr>
<td>Ctrl + u</td>
<td>Clear item field</td>
</tr>
<tr>
<td>Tab</td>
<td>Next item field</td>
</tr>
<tr>
<td>Shift Tab</td>
<td>Previous item field (reverse direction)</td>
</tr>
<tr>
<td>Ctrl + q</td>
<td>Acts as ‘exit’ button – cancels a query or exits current form</td>
</tr>
</tbody>
</table>
When using the mouse to access various parts of Banner, be aware, the majority of these steps will be achieved through a SINGLE mouse click.

Use a double mouse click:
1) To activate a field lookup where a field name is in blue.
2) To return a date or value when working in the calendar or calculator.
3) In an ID field to select specific record.
On Your Own Activity: Parts of a Form

1. Identify these form items by writing the correct name in the blank boxes next to the item using the terms in the column below.

   Activity 1 Terms:
   
   A. Alert box
   B. Hyper-links
   C. Blocks
   D. Key Block
   E. Dialog box

2.  
3.  
4.  
5.  

Lesson 2: Getting Started With Banner Student

Lesson Activity – Name the Parts
In this lesson you:

• Learned how to log-on to Banner Student (Topic 1)
• Identified the parts of the Banner Student interface (Topic 2)
• Learned names for parts of a form and the typical form layout (Topic 3)
• Learned about multiple parts to a form (Topic 4)
• Saw the function of hyperlinks for moving inside a form (Topic 4)
• Identified the elements of a Banner Student form (Topic 5)
• Learned how to use the mouse & keyboard to get around Banner Student (Topic 6)
Lesson 3: Accessing Banner Student Forms
Lesson Overview

Much like other software applications, there are multiple methods and procedures for navigating within the software in order to complete a task.

Banner Student provides you with several ways to find and work with various forms. As you become familiar with Banner Student, you will be able to move about easily through the screens.

Lesson Agenda

Topic 1: Primary form types used in Banner Student
Topic 2: Form Names - what they can tell you about a form’s function
Topic 3: How to access Banner Student forms using
  – Main Menu
  – Direct Access
  – Last 10 Forms list on the File menu
Topic 4: Using buttons inside of a form
The Banner Student Information System uses six types of forms. However, as an everyday user of the system, you will only use the following three form types:

- **Application & Maintenance Forms:** Use these forms to enter and update information. This is one of the most common types of forms.

- **Inquiry & Query Forms:** Use these forms to look up existing information, often returning information to a “calling” form.

- **Validation Forms:** Forms used to define values that can be entered into specific fields on application forms.

**What you will learn in this topic:**

- The use of application & maintenance forms
- The use of inquiry & query forms
Application forms are used to enter, update, and occasionally query information in Banner Student. This is one of the most common types of forms you will use in Banner Student.

Note: Application and Maintenance forms are virtually identical in purpose and function. The terms can be used interchangeably.
Inquiry forms are used to look up existing information, often returning that information to the previous (calling) form.

You can access an inquiry form from the main menu; from another form; or with Direct Access.

The Source/Background Institution Query Form (SOISBGI) is an example of an inquiry form.
Validation forms Use these forms to define the values that can be entered in specific fields on application forms. These values are used/consistent throughout Banner.

You can access these codes via any of the following methods:
- Clicking the “search” button alongside a field
- Double-click a field whose name is in blue text
- Click the “LIST” function on the help menu when in a form field.

To select a value:
- Double-click the item
- Single click the item and then click on the “OK” button.
On Your Own Activity: Types of Forms

List the three types of forms you will use in Banner Student, on the correct line, for how they are used.

- Used to enter, update & query information
- Used to look up existing information
- Used to access a list of valid values for a specific data field.

Lesson 3: Accessing Banner Student Forms
Topic 1: Types of Banner Forms
Each form in Banner Student has a 7 character name – this name is an acronym which tells you about the type of information it contains, the University business process it is related to, and much, much more.

What you will learn in this topic:
How to interpret the 7-character name of a form
Discussion: Understanding Form Names – Continued

Position 1:
Identifies the **primary system** owning the form

Position 2:
Identifies the **business process** (module) owning the form

Position 3:
Identifies the **form type**

Position 4-7:
Uniquely identifies the form

- **S**: Accounting (T)
- **P**: General Person (P)
- **A**: Application (A)
- **IDEN**: Identification (IDEN)
- **1**: General Person (P)
- **2**: Application (A)
- **3**: Identification (IDEN)
- **4-7**: General Person (P)

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4-7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Control (N)</td>
<td>Budget (B)</td>
<td>Inquiry (I)</td>
<td>Position (POSN)</td>
</tr>
<tr>
<td>Student (S)</td>
<td>Benefit/Deductions (D)</td>
<td>Verification/Values table (V)</td>
<td>Totals (TOTL)</td>
</tr>
<tr>
<td>Financial (F)</td>
<td>Employee (E)</td>
<td>Maintenance (M)</td>
<td>Employee (EMPL)</td>
</tr>
<tr>
<td>Etc…</td>
<td>Electronic Approvals (R)</td>
<td>“Overall” to a business process (O)</td>
<td>Job information (JOBS)</td>
</tr>
<tr>
<td>Etc…</td>
<td>“General” to a business process (G)</td>
<td>Etc…</td>
<td>Faculty info (FACT)</td>
</tr>
</tbody>
</table>

Lesson 3: Accessing Banner Student Forms
Topic 2: Understanding Form Names
### Discussion: Understanding Form Names – Continued

#### Some examples...

<table>
<thead>
<tr>
<th>Position 1:</th>
<th>Example: SAAADMS</th>
<th>Example: SOISBGI</th>
<th>Example: SPAIDEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifies the primary system owning the form</td>
<td>$S$=Student</td>
<td>$S$=Student</td>
<td>$S$=Student</td>
</tr>
<tr>
<td>Position 2:</td>
<td>A=Admissions</td>
<td>O=Overall</td>
<td>P= Person</td>
</tr>
<tr>
<td>Identifies the business process (module) owning the form</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position 3:</td>
<td>A=Application form</td>
<td>I = Inquiry</td>
<td>A = Application</td>
</tr>
<tr>
<td>Identifies the type of form</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position 4-7:</td>
<td>ADMS= Admissions</td>
<td>SBGI= Source\Background Institution</td>
<td>IDEN= Identification information</td>
</tr>
<tr>
<td>Uniquely identifies the form</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For the Banner form SGASTDN, fill in the blanks below, identifying the elements of the form name:

1) Primary system owning the form
2) The module owning the form
3) The type of form
4) The unique identification of the form

S= 
G= 
A= 
STDN= 
Every time you log on to Banner Student, Banner opens to the “Main Menu”. From here, three methods by which you can open a specific form are available.

What you will learn in this topic:

- How to navigate to a specific form using Main Menu folders
- How to navigate to a specific form using the Direct Access field on the Main Menu
- How to navigate to a specific form using the Last 10 Forms option
Discussion: Main Menu Access to Forms

You can navigate to a specific form using the ‘main menu’.

Some menus may be nested within (i.e. found inside) another menu. These nested menus will be *indented* (but not much!)

**NOTE:** the “Products” menu contains Banner Student related forms

Lesson 3: Accessing Banner Student Forms
Topic 3: Using the Main Menu, Direct Access & Last 10 Forms
Procedure: Main Menu Access to Forms

To Expand a Menu Steps:
1) Click Products menu
2) Click Student System Menu name in the left pane
3) Click General Person Menu

The right pane portion of the window now lists the contents of the General Person Menu.
Discussion: Direct Access

You can use Direct Access to open a menu or form by typing its seven-character name into the Direct Access field and pressing the enter key.

You can use Direct Access from the main menu/screen or from within a form.
Discussion: Direct Access

Direct Access Steps:

With Banner open:
1) Enter the seven-character name of the desired form in the Direct Access field
2) Press Enter
The requested form is opened
### On Your Own Activity: Direct Access

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>With Banner open</td>
<td></td>
</tr>
<tr>
<td>1) Type SOAIDEN in the <strong>Direct Access</strong> field</td>
<td>The text SOAIDEN is in the Direct Access field</td>
</tr>
<tr>
<td>2) Press <strong>Enter</strong></td>
<td>SOAIDEN opens</td>
</tr>
<tr>
<td><em>Click Exit (or ctrl/Q) to return to the main menu</em></td>
<td></td>
</tr>
</tbody>
</table>
Discussion: Last 10 Forms Used

You can quickly re-access a form that was previously opened in the current session. The bottom of the ‘File’ pull-down menu lists the last forms (up to 10) you have used.

• Click the File menu
• Click the desired form
Procedure: Last 10 Forms

Procedure:
From the main menu

1) Click the File menu

2) Select the GOAEMAL form

GOAEMAL opens

Click Exit to return to the main menu
### On Your Own Activity: Last 10 Forms

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>With Banner open:</em></td>
<td></td>
</tr>
<tr>
<td>1) Click the <strong>File</strong> menu on the menu bar</td>
<td><strong>File</strong> pull-down menu opens</td>
</tr>
<tr>
<td>2) Select / click the <strong>SOAIDEN</strong> form</td>
<td><strong>SOAIDEN</strong> form opens</td>
</tr>
<tr>
<td><em>Click Exit to return to the main menu</em></td>
<td></td>
</tr>
</tbody>
</table>

**Remember:** Only the last 10 forms you have accessed since you logged on to Banner Student **today** will show up in the lower portion of the **File** menu.
An additional method of getting around inside of Banner is the use of buttons *inside* of a form.

Here we’ll explore the various ways these buttons can be used.
Discussion: Navigation using Buttons Inside a Form

You can use buttons inside a form to access another form, or window related to the record or field where the cursor is currently located. Iconic buttons are small squares that contain an icon (picture). They represent one or more actions that can be performed for the associated field or record.

For example, you can use iconic buttons to display a validation form for the field; copy a record; or display a window for entering freeform text.

EXAMPLE: 1) click the “search button” next to the name field … 2) this loads the SOAIDEN form where you can search for an individual’s record.
Follow this next example to searching for a specific person’s record.

1) Click this button.

2) Search options box appears (the “BIG LIE”)

3) This query form opens – Execute a query for the information you’re looking for, and double-click on the record, or click the “select item” toolbar button (or shift/F3) to return the information to the “calling” form.
On Your Own Activity: Buttons Inside a Form

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open SPAIDEN</td>
<td></td>
</tr>
<tr>
<td>1) Click the <strong>Search</strong> button</td>
<td>The form or window associated with <em>Search</em> button appears.</td>
</tr>
<tr>
<td>2) Click 'person search' in the popup box</td>
<td>Specifies this search to look for a ‘person’</td>
</tr>
<tr>
<td><em>The Person Search Form opens</em></td>
<td></td>
</tr>
<tr>
<td><em>Exit both the search form and SPAIDEN</em></td>
<td>Use the exit toolbar button, or ctrl+q 2 times</td>
</tr>
</tbody>
</table>

Lesson 3: Accessing Banner Student Forms
Topic 4: Activity - Buttons Inside a Form
On Your Own Activities: Accessing Banner Student Forms

Activity 1:

The four ways to access forms in Banner Student are:

1) 
2) 
3) 
4) 

Activity 2:

For this activity, there are two parts:

A) Open Banner and access the identification form SPAIDEN using the left and right window panes from the main menu. (Hint: Found on the General Person Menu).

After you have successfully opened the form, click exit to return to the main screen.

B) Open the same form from the main menu, but this time use the Direct Access field.

After you have successfully opened the form, click exit to return to the main screen.
In this lesson you:
Learned about the various types of Banner forms, primarily **application, maintenance & inquiry** forms. (Topic 1)
Learned about the way Banner form names are constructed, and how to decipher their function. (Topic 2)

Learned some of the ways to move (or navigate) through Banner Student and access forms by using the following methods:
**Main Menu:** You can select from a list of menus and forms in Banner. (Topic 3)

**Direct Access:** You can access a menu or form by its seven-character name, or you can use the code/description lookup feature. (Topic 3)

**Last 10 forms in the File pull-down menu:** You can quickly re-access a form that was previously opened in the current session. (Topic 3)

**Buttons Inside a Form:** You can access another form or window related to the current record or field via form buttons. (Topic 4)
Lesson 4: Banner
Student Inquiries
Lesson Overview
Perhaps one of the most powerful features of Banner Student is the ability to search for information.

Banner Student allows you to search for information using query functions available throughout the Banner.

Another way Banner Student allows you to search is by using forms specifically designed for performing inquiries.

Lesson Agenda
- **Topic 1**: Query basics, wildcards
- **Topic 2**: How to perform a query using an inquiry form
- **Topic 3**: How to perform a query using an application form
- **Topic 4**: How to perform a query using a form field
Querying is the process of looking to see what information is already entered in the Banner database. You can use inquiry forms, query forms, and most application forms to perform queries.

Some forms automatically open in query mode, usually because a large number of records would have to be retrieved. When a form opens in query mode, **Enter Query** appears in the status line. You can immediately specify search criteria to narrow the search.
Discussion: Wildcards In A Search

You can use the wildcards, “%” and “_” in defining the search criteria.

The % character represents any number of unspecified characters.

The “_” (underscore) character represents a single, unspecified character.

NOTE: With experience, it becomes easier to narrow your queries to get the results you want.

<table>
<thead>
<tr>
<th>Examples:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To get these results:</strong></td>
<td><strong>Enter this criteria:</strong></td>
</tr>
<tr>
<td>All entries that contain “ma” after the first letter in the name</td>
<td>%ma%</td>
</tr>
<tr>
<td>All entries that begin with “ma”</td>
<td>ma%</td>
</tr>
<tr>
<td>All entries that begin with “ma” but are only 3 characters</td>
<td>ma_</td>
</tr>
<tr>
<td>All entries that have “ma:” as the last two characters</td>
<td>%ma</td>
</tr>
<tr>
<td>All entries that have “m:” as the second character</td>
<td>_m%</td>
</tr>
<tr>
<td>All entries that begin with “s”, but have only 5 characters</td>
<td>s_ _ _ _</td>
</tr>
</tbody>
</table>
Procedure: Performing a Query

Here are the basic steps to performing a query in Banner. These most closely illustrate the search process using either application or inquiry type forms.

1. Access the form to run the search in.
2. If the form opens in query mode (Enter Query is in the status line), go directly to step 3. If the form is not in query mode, click the Enter Query toolbar button or press the F7 key.
3. Enter the search criteria. You can query information in any field that you can access.

   **NOTE!**
   
   *Capitalization DOES matter!*

4. Click the Execute Query toolbar button or press the F8 key. The form then displays all records that match the search criteria.

   **NOTE:** To start a new search, or revise the current search, use the “Rollback” function – either via the toolbar button or shift+F7.
## On Your Own Activity: Perform a Query Using an Inquiry Form

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Open SOISBG1</td>
<td></td>
</tr>
<tr>
<td>2) Tab 2 times to move cursor to the “Source/Background Institution” field/column - - Type “A%” (w/o quotes) in the ID field</td>
<td>To display all Institutions that begin with the uppercase letter A</td>
</tr>
<tr>
<td>3) Click the Execute Query icon or press the F8 key.</td>
<td>Executes the query</td>
</tr>
<tr>
<td>4) Ctrl+q to exit the SOISBG1 form</td>
<td>Returns to the main Banner screen</td>
</tr>
</tbody>
</table>

**NOTE:** Be sure to enter search criteria with proper **capitalization**!
Results: Perform a Query Using an Inquiry Form

Additional query / search options are listed on the options menu.
Discussion: Query Using an Application Form

Using the search button (1) in an application form initiates the query process as outlined 3 pages back. The advantage here is that once the record you’re looking for is found, it can then be “returned” to the original form where you can work on it (enter/update information).

Note: If you find a query results in too many matches (like 399!), you could use the rollback (shift/F7) function to re-enter the search parameters. For example, adding some portion of a first name to supplement a query based on only last name data, would narrow the results without risk of missing the desired individual’s record.
Upon finding an individual’s record and “sending” it back to the ‘calling form’, you can then easily access further information about that person.

Identification information for the individual is shown here. You also have access to other sub-forms which display further identification data through the use of the hyperlinks.

The following hands-on activity will demonstrate this, and ends at the “System Identification Form”, where we see all the various ways in which this individual is entered in the Banner system.
## On Your Own Activity: Query Using an Application Form

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Open <strong>SPAPERS</strong> via Direct Access</td>
<td>Loads General Person form</td>
</tr>
<tr>
<td>2) Click search button next to name field</td>
<td>Initiates a query – loads SOAIDEN form</td>
</tr>
<tr>
<td>3) Tab to the 'last name' field and enter “des_” as the search criteria -- set “case sensitivity” to NO,</td>
<td>To find records with 4 letter last names that start with “des”. Verify that “Case sensitive query” is set to <strong>No</strong></td>
</tr>
<tr>
<td>4) Click <em>Execute Query</em> on the toolbar, or keyboard F8.</td>
<td><em>Runs the search</em></td>
</tr>
</tbody>
</table>

*If you get too many matches here, you might want to try the *rollback* function and add some part of the first name…*

| 5) Double click the I.D. for **Robert Isaac Dess OOO**               | **Robert Isaac Dess OOO** information is returned to the SPAPERS form. |
| 6) “Block next” using the toolbar or ctrl+pg down on the keyboard    | *Block next* causes the data to populate the record fields. |

---

**Lesson 4: Banner Student Inquiries**

**Topic 3: Activity - Query Using An Application Form**
Procedure: Performing a Query from a Form Field

1. In a form field (i.e. ID, Name, etc), enter the search parameters –
2. Press the **Enter** key.
3. Click on the down arrow next to the ‘Search Results’ field to display the matching records.
4. Click on the desired record to return it to the form.
Discussion: Performing a Query from a Field (cont.)

Other options within the pop-up search results window:
A. Confine the search to person or ‘non-person’.
B. Cancel this search and return to the form.
C. Narrow the search by city, state, zip code, birth date, etc.

D. Click on this button to re-run the query using additional search parameters.

Lesson 4: Banner Student Inquiries
Topic 4: Perform A Query From A Form Field
### ACTIVITY 1

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Open SGASTDN via Direct Access</td>
<td>Loads “General Student Form”</td>
</tr>
<tr>
<td>2) Click or tab into the Name field (delete any entry in the ID field, if there)</td>
<td>Positions cursor in field to be searched on</td>
</tr>
<tr>
<td>3) Type “lejt%” (w/o quotes) in the Name field</td>
<td>To display all entries that begin with the characters “lejt”. (NOTE this form of search is NOT case sensitive)</td>
</tr>
<tr>
<td>4) Hit the enter key</td>
<td>Enter executes the query</td>
</tr>
<tr>
<td>5) Click down-arrow next to ‘search results’ field – single click the record for Rannia Lejtjep</td>
<td>A single click will select and return the specific student record to the calling form</td>
</tr>
<tr>
<td>6) Click Next from the Block menu -or- press Ctrl+PageDown keys.</td>
<td>“Populates” the lower block’s fields with the applicable information..</td>
</tr>
</tbody>
</table>

---

### ACTIVITY 2

Do the same steps above but using the SPAIDEN form and “hsuw%” in the Name field – experiment with narrowing the search by person versus non-person
Review: Banner Student Inquiries

In this lesson you:

• Defined what a query/inquiry is (Topic 1)
• Defined available search ‘wildcard’ options (Topic 1)
• Performed a query using an inquiry form (Topic 2)
• Performed a query using an application form (Topic 3)
• Performed a query from a form field (Topic 4)
Lesson 5: An Introduction to General Person
Lesson 5: An Introduction to General Person - Overview & Agenda

Lesson 5: An Introduction to General Person

Topic 1: An Overview of the General Person Module
Topic 2: Verification of a Student in Banner
Topic 3: Access Identification Information
Topic 4: Querying Additional Information in Banner Student
Topic 1: An Overview of the General Person Module

The Student Information System supports the full range of functions necessary for student administration. Specifics include: the creation of catalogs, data collection for scheduling of classes, admissions, assignment of housing and faculty workload analysis. The Banner Student system also includes registration; all accounts receivable; academic history and degree audit reporting.

The General Person module is used to enter biographic and demographic information, query and display all address information, and record multiple phone numbers for all entities associated with the institution.
Before a person can become a recruit, applicant, student, instructor, advisor, or have an account, that person must first be identified to the system with an identification number and name. The Person Search Form (SOAIDEN) is initially checked to see if a person already exists in the system.

The Person Search Form may be accessed from all forms that require an ID number in the Key Information. This form may be used to determine the correct ID number for a person using the query capabilities of the system.

The name, ID number, birth date, change indicator (an indicator to record name and ID changes--blank for the current record), and name type are displayed.
Procedure: Verification of a Student in Banner Student

1. Navigate to the Person Search form by typing SOAIDEN into the direct access field. The form will appear.
2. Perform a search for using the wildcards % and _ along with a portion of the last name, in the search criteria.
3. Click the “no” radio button to query without regard to case sensitivity.
Procedure: Verification of a Student in Banner Student

4. Execute the Query using the method you most prefer. The form displays all records that match the search criteria. If the person is NOT found in the Banner system...

5. Rerun the search, but this time, use the available last name information in the first name field as a cross-check. If the person does not show up in either of the search results, then you can be confident they have not previously been entered into the Banner System.

NOTE: Remember, to start a new search or query, use the "Rollback" function – either via the toolbar button or shift+F7.
On Your Own Activity: Verification of a Student in Banner Student

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open SOAIDEN</strong></td>
<td>Loads General Person form</td>
</tr>
<tr>
<td>1) Type “cashisniotvis” in the “Last name” field and set “case sensitivity” to NO.</td>
<td>To locate targeted individual’s data to be worked on – Verify that “Case sensitive query” is set to <strong>No</strong></td>
</tr>
<tr>
<td>2) Click <strong>Execute Query</strong> on the toolbar, or F8 on the keyboard.</td>
<td>Executes the Query.</td>
</tr>
</tbody>
</table>

**Reminder:** if the targeted person had not been found, this is the point where the query would be re-run using the **last name** information in the **first name** field.

---

**Alternative Verification Strategy**

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open SPAIDEN</strong></td>
<td>Loads General Person form</td>
</tr>
<tr>
<td>1) Type “cashisniotvis” in the “Last name” field (you could also try “cashisn%” for the search parameter)</td>
<td>To locate targeted individual’s data to be worked on –</td>
</tr>
<tr>
<td>2) Press the “enter” key</td>
<td>Executes the Query.</td>
</tr>
<tr>
<td>3) Since there is only one Cashisniotvis in the database, the record automatically loads into the SPAIDEN form</td>
<td><strong>000162476</strong> information is returned to the SPAIDEN form and the lower blocks filled in.</td>
</tr>
</tbody>
</table>
The Identification Form (SPAIDEN) is used to capture both biographic and demographic information for all entities associated with the institution.

A person may belong to any or all of the installed applications (Student, Finance, etc.). All entries are entered into the database via the SPAIDEN form. The information maintained in this form is specific to the person and does not relate to the person's involvement at the institution.

All other modules/applications are dependent on the information captured and maintained in this form. Any changes or additions to biographic or demographic information must be made with this form.
Navigate to the SPAIDEN form.
1) Type SPAIDEN into the Direct Access field on the Banner Main Menu and touch the Enter key. The Identification Form will appear.
Procedure: Accessing Identification Information

2) Enter search criteria into name field - press enter to execute the search.

NOTE: remember that this form of searching is **not** case sensitive!
Procedure: Accessing Identification Information

3) Click on target individual’s name in the search results pull down list.

**NOTE:** The example here is *Susan Nd Efent* whose last name contains a space. This illustrates that Banner recognizes the space as a searchable character.
5) The name and ID# for Susan Nd Efent is returned to the SPAIDEN form.

6) Block Next to populate the Current Identification block.
### On Your Own Activity: Accessing Identification Information

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open <strong>SPAIDEN</strong></td>
<td>Loads Identification form</td>
</tr>
<tr>
<td>1) Type “cashis%, d%” in the name field - press <strong>Enter</strong></td>
<td>Initiates a query based on this last name, first name data</td>
</tr>
<tr>
<td>2) In the resulting search result popup box, enter an ‘F’ into the</td>
<td>Further refines the search to those initial matches which are female</td>
</tr>
<tr>
<td>gender field</td>
<td></td>
</tr>
<tr>
<td>3) Click the searchlight button, or F8 to execute revised search</td>
<td>Banner will execute new search criteria based query</td>
</tr>
<tr>
<td>4) Click ‘Diane Marie Cashisniotvis’ in the list of names that remain</td>
<td>Diane’s record is returned to the SPAIDEN form</td>
</tr>
<tr>
<td>5) Block next, moving into the next lower block of information</td>
<td>Presents Diane’s current identification information</td>
</tr>
<tr>
<td>6) On the Options menu, click the <strong>Alternate Names/I.D</strong> hyperlink</td>
<td>Displays alternate name/ID information - if available</td>
</tr>
<tr>
<td>Exit – ‘red door’ toolbar exit button, or ctrl+q one time</td>
<td>Returns to Banner main menu screen</td>
</tr>
</tbody>
</table>
The Identification number or name of the last entity chosen in the using the SOAIDEN form will populate the ID field on the SPAIDEN form.
Procedure: Querying Additional Information in Banner Student

Once a person has received an Identification number, additional information can be entered to further identify them in the system.

NOTE: The Identification number or name of the last student’s record in previous forms will populate the ID field on the SPAIDEN form.
1) Touch the Ctrl + Page Down keys to populate the next block on the SPAIDEN form.
Procedure: Querying Additional Information in Banner Student

2) Click the options drop down menu. The drop down menu will appear.
3) Click on Addresses as the selection in the drop down menu.

4) The Address Information Form will appear displaying the current address for the student selected.

To query for additional information, repeat the actions as previously demonstrated when accessing student address information.

Remember! You can only view information about a student that your security access will allow.
Discussion: Querying Additional Information in Banner Student

The contents of the options drop down menu will vary depending on which form in Banner you choose to access additional information about the student selected.
## On Your Own Activity: Querying Address Information in Banner Student

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open SPAIDEN</strong></td>
<td>Loads General Person form</td>
</tr>
<tr>
<td>1) Query Banner for ‘Diane Marie Cashisniotvis’ address.</td>
<td>Diane ‘Marie Cashisniotvis’ information is currently stored in the SPAIDEN form as she is the last entry.</td>
</tr>
<tr>
<td>2) Click on the Options drop down box.</td>
<td>The Options drop down menu is displayed.</td>
</tr>
<tr>
<td>3) Click the Addresses hyperlink on the Options menu</td>
<td>Retrieves address information for display in the Address Information Form.</td>
</tr>
<tr>
<td>4) Click the Telephone Numbers hyperlink on the Options menu</td>
<td>Opens the SPATELE form on top of SPAIDEN</td>
</tr>
<tr>
<td>5) Block next to move to specific telephone number information</td>
<td>Populates lower blocks with available telephone numbers</td>
</tr>
<tr>
<td>6) Click the E-Mail Addresses hyperlink on the Options menu</td>
<td>This opens the GOAEMAL form on top of SPATELE</td>
</tr>
<tr>
<td>7) Block next to move to specific email information</td>
<td>Populate lower blocks with available email information</td>
</tr>
<tr>
<td>8) Exit two times (ctrl+q or ‘red-door’ exit)</td>
<td>Note how this closes the last 2 forms opened via hyperlinks - thus returning to SPAIDEN</td>
</tr>
</tbody>
</table>

**Just for fun**

| 9) Click the System Date Summary hyperlink  |                                                                                  |

---

*Lesson 5: An Introduction to General Person*

*Topic 4: Querying Additional Information in Banner Student*
In this lesson we discussed:

- An Overview of the General Person Module (Topic One)
- Verification of a Student in Banner Student (Topic Two)
- Access Identification Information (Topic Three)
- Querying Additional Information in Banner Student (Topic Four)
Lesson 6: Features in Banner Student
Lesson Overview
Banner is equipped with many convenient features such as a calendar and calculator functions. As you become more proficient working with Banner, you'll find these features, and others, very useful.

Lesson Agenda
Topic 1: How to use the calculator and calendar
Topic 2: Customizing Banner
Topic 3: How to change your Banner password
Banner’s *calculator* and *calendar* functions are conveniently *connected* to related fields within every Banner form. A double click within a field for either a date or numeric type data will activate the associated calculator or calendar tool.

- If the form’s *numeric* field has a value, the calculator starts with that value. You can then use the mouse, number keys on the keyboard, or the numeric keypad (if the Num Lock is enabled) to make calculations.

- If the *date* field has a value, the calendar starts with that date highlighted. If the date field is empty, the calendar highlights the current date.
Discussion: Using The Calculator

If you access the calculator via a double-click in a numeric form field, clicking the OK button will return the calculated value to the ‘calling form’.

You can also access the calculator via Direct Access by typing in GUACALC. When accessed this way, the calculator works independently of any form or field and you cannot return a calculated value to a form.
Discussion: Using the Calendar

Accessing the calendar via a double-click in a date field allows you to double-click the desired date to return that value to the ‘calling form’.

You can also access the calendar with Direct Access by typing in GUACALN. When accessed this way, the calendar works independently of any form or field. This means you cannot select a date and return it to a form.
Procedure: Using the Calendar

Procedure:
In a Banner form:
1. Place the cursor in a date field
2. Double-click in the date field to open the calendar
3. Select a date
4. Click OK to populate the date field with the selected date

Here we’ve used the SOAHOLD form to illustrate these steps.
On Your Own Activity: Using the Calendar

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Open the <strong>SPAIDEN</strong> form</td>
<td>The form opens.</td>
</tr>
<tr>
<td>2) Block Next / ctrl+pg down</td>
<td>Moves cursor to next block, and populates data fields</td>
</tr>
<tr>
<td>2) Click the Addresses <strong>hyperlink</strong> on Options Menu</td>
<td>Opens addresses sub-window</td>
</tr>
<tr>
<td>3) Double-click in the “From” field</td>
<td>The calendar appears.</td>
</tr>
<tr>
<td>3) Select a date of your random choice</td>
<td>The date is highlighted</td>
</tr>
<tr>
<td>Note: a <strong>double-click</strong> of the desired date would automatically return that data to the form field.</td>
<td></td>
</tr>
<tr>
<td>4) Click the <strong>OK</strong> button</td>
<td>The date selected returns to the date field.</td>
</tr>
</tbody>
</table>
You can customize toolbar and form display options. With the toolbars, you can display or hide the horizontal toolbar and bubble help. With the forms, you can include or exclude certain information on title bars.

Banner also allows you to easily change your password.

**What you will learn in this topic:**

- How to customize Banner display options
- How to customize Banner toolbar display options
- How to change your password
Procedure: Customizing Form Display Options

Procedure:
1. From the File menu, select Preferences, or open GUAUPRF via Direct Access
2. Click the Forms Display Options button if necessary
3. Clear the options you don’t want to use
4. Click the OK button
5. Click OK for the dialog box
6. Exit Banner
7. Restart Banner

Note: Form name display options should be set to both Menu Bar and Options/Navigation frame. This will provide the form name ‘pop-up’ feature for hyperlinks.

You must exit and restart Banner to see your changes.
### On Your Own Activity: Customizing Form Display Options

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Open <strong>GUAUPRF</strong> via Direct Access</td>
<td>The General User Preferences Maintenance Form opens.</td>
</tr>
<tr>
<td>2) Click the <strong>Forms Display Options</strong> button if necessary</td>
<td>The graphic pane moves to show the forms display options.</td>
</tr>
<tr>
<td>3) Clear the options you don’t want to use</td>
<td>You’ve selected options you don’t want to use with Banner any more.</td>
</tr>
<tr>
<td>4) Click the <strong>OK</strong> button</td>
<td>A dialog box says you must exit and restart Banner to see the changes.</td>
</tr>
<tr>
<td>5) Click <strong>OK</strong> for the dialog box</td>
<td>The dialog box closes.</td>
</tr>
<tr>
<td>6) Exit Banner</td>
<td>Banner Closes</td>
</tr>
<tr>
<td>7) Restart Banner</td>
<td>Your changes will now be set in Banner.</td>
</tr>
</tbody>
</table>
There are a number of reasons why you might want to change your Banner password, so here’s the procedure to use…

NOTE: You CAN make your Banner (Oracle) password the same as the password you use for WSU e-mail, as long as it does not start with a number.
Procedure: Changing Banner Password

Procedure:
1) Type GUAPSWD in the Direct Access field
2) Type your current password into “current Oracle password” field
3) Type a *NEW password in the “new Oracle Password” field*
4) Tab to “verify password” field and re-type your new password
5) Click the SAVE button
   (a message window displays: “Password being changed, reconnecting”)
5) Click OK or press the enter/return key

*NOTE: Do NOT start your new password with a number! If you do, the system will not respond and will not even display an error message.

Lesson 6: Features in Banner Student
Topic 3: Changing the Banner Password
In this lesson you learned how to do the following:

• Use the calculator function of Banner Student (Topic 1)
• Use the calendar function of Banner Student (Topic 1)
• Customize form display options (Topic 2)
• Change your Banner user password (Topic 3)
Congratulations!

You should now be able to perform the following:

- Navigate in Banner Student
- Execute basic Banner Student inquiries

With these skills you will be able to use Banner Student efficiently and effectively. While these skills are fresh in your memory, be sure to apply them as soon as possible when back at your computer.

We have created a training version of Banner / FMS which will allow you to use these skills right away. This training version is Banner V5.x Sandbox as found at:

http://bantest.wayne.edu

Feel free to perform whatever functions you wish in this training version. You cannot harm any data while working in the “sandbox”, so jump in!

Thank you for all your effort and time!

Reminder!
Sandbox username = trainxx
Sandbox password - xx
xx=2 digit number from 51-99
Appendix 1 - Banner Web Access
Lesson Overview

A look at the steps needed to enable our internet browser to run Banner 5.x.

Lesson Agenda

- Topic 1: System requirements
- Topic 2: Oracle browser plugin - downloading & installation
- Topic 3: Making a required setting to properly run FMS 5x
Appendix 1: System Requirements

System requirements for running Banner Web FMS 5.x

- Browser: Internet Explorer (IE) version 5.5*, service pack 2, or Internet Explorer 6.0
- CPU: Pentium with 100–133 MHz or higher processing speed
- RAM: 64 MB or more, depending on use of other software, such as Microsoft Office
- Free Hard Drive Space: 20 MB

* If you are not sure which Web browser version you are using, click on the Help pull down menu at the top of the browser window and select About...
Topic 1: System Requirements

For the latest system specifications, FAQ and related Banner information, browse to:

http://support.wayne.edu

Click the link to:

“Go to Banner information from here”
In addition to having links to the latest system requirements, you'll find links to:

- Versions of Internet Explorer.
- Specific computer hardware configuration requirements.
- Contact information to Training & Development.
- Banner “Frequently Asked Questions" (FAQ) list.
- Many other sources of relevant and helpful information.

Banner2000 System at Wayne State University
C&IT Online Help

- Access
  - Web-based Banner Version 5
  - Banner Ad-hoc Reporting (BAR) and SMARTCOLD
  - Banner System Availability

- Requirements
  - Developing Computer Configurations
  - Software Requirements for Banner Version 5
  - Passwords Used to Access Banner
  - Changing Your WSU Banner Password

- Reporting
  - Banner Reporting Options

- Training
  - General Information
  - Stand-up Training — Contact WSU’s Training & Development Office for schedules and registration information.

- Troubleshooting
  - Banner Version 5 FAQs
  - BAR and SMARTCOLD Connections

- News
  - Recent Messages
  - Historical Information (some links on these pages may be broken)
First thing is to launch Internet Explorer.

In the address field, type the internet address of the WSU Banner Web site:

http://banner.wayne.edu

… and click the “go” button, or hit the enter key.

Helpful hint: to make a shortcut to this location on your desktop, simply click the icon (as highlighted in this illustration) and while still holding the mouse button down, drag the icon out to your windows desktop and release the mouse button.
With this first visit to the WSU Banner access page, a process will automatically start to download and install a piece of software that will allow your browser to properly run Banner.
The “Security Warning” dialog box will appear -- Click on the “Yes” button to proceed with downloading the plug-in file.
Topic 2: Oracle Browser Plug-in

At this point, click the “X” button in the Internet Explorer window. This will **exit** and close this window.

Notice the “InstallShield” dialog box remains on the screen.
Next up will be the confirmation of the installation - click the YES button.
Click the ‘Next’ button.

Accept the suggested ‘destination directory’ by clicking ‘Next’.
Topic 2: Oracle Browser Plug-in

Click the OK button to finish the installation of the plug-in!

Oracle JInitiator 1.1.8.14

Installation Complete

Oracle JInitiator installation is complete. If you are using Netscape as your web browser, you will need to close and restart Netscape before using JInitiator.

OK
There is one more step required to fully prepare the browser to access Banner 5.x.

At your Windows desktop, follow these steps:
1) Click on “Start” button.
2) Click on “Programs” item.
3) Click on “JInitiator Control Panel 1.1.18.14”.
In the Oracle JInitiator Properties box:

1) Click on the down-arrow as indicated by the box in the diagram.
2) Click on “Unrestricted” menu item
3) Click on “Apply” button
4) Click on “X” in upper right hand corner to exit this application.

Congratulations! Your computer is now fully prepared to run Banner 5.x!
Appendix 2 - Quick Reference
Appendix – Quick Reference

We’ve brought together some of the key information from this session for quick reference:

• Toolbar buttons reference chart
• Keyboard Shortcuts chart
• Form name basics
• Most commonly used inquiries forms
Review: Accessing Banner Student Forms

In this lesson you:
Learned about the various types of Banner forms, primarily application, maintenance & inquiry forms. (Topic 1)

Learned about the way Banner form names are constructed, and how to decipher their function. (Topic 2)

Learned some of the ways to move (or navigate) through Banner Student and access forms by using the following methods:

**Main Menu:** You can select from a list of menus and forms in Banner. (Topic 3)

**Direct Access:** You can access a menu or form by its seven-character name, or you can use the code/description lookup feature. (Topic 3)

**Last 10 forms in the File pull-down menu:** You can quickly re-access a form that was previously opened in the current session. (Topic 3)

**Buttons Inside a Form:** You can access another form or window related to the current record or field via form buttons. (Topic 4)
When you pause your mouse arrow over a toolbar button, a yellow bubble appears with text that describes the function of the button.
Getting Around Using the Mouse & Keyboard

Here's a collection of some of the most useful keyboard shortcuts.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl F1</td>
<td>Display “Show Keys” window</td>
</tr>
<tr>
<td>F2</td>
<td>count query hits</td>
</tr>
<tr>
<td>F3</td>
<td>SELECT record</td>
</tr>
<tr>
<td>F4</td>
<td>Record duplicate</td>
</tr>
<tr>
<td>F5</td>
<td>Clear block</td>
</tr>
<tr>
<td>F6</td>
<td>Insert record</td>
</tr>
<tr>
<td>F7</td>
<td>Rollback</td>
</tr>
<tr>
<td>F8</td>
<td>Execute query</td>
</tr>
<tr>
<td>F9</td>
<td>List – Search</td>
</tr>
<tr>
<td>F10</td>
<td>Save changes</td>
</tr>
<tr>
<td>Ctrl + pg</td>
<td>Next block</td>
</tr>
<tr>
<td>Ctrl + u</td>
<td>Clear item field</td>
</tr>
<tr>
<td>Tab</td>
<td>Next item field</td>
</tr>
<tr>
<td>Shift Tab</td>
<td>Previous item field (reverse direction)</td>
</tr>
<tr>
<td>Ctrl + q</td>
<td>Acts as 'exit' button – cancels a query or exits current form</td>
</tr>
</tbody>
</table>

**NOTE:** Data entry users will make good use of these “permission-based” shortcuts:
- F4  Duplicate record
- F6  Insert record
- Shift/F6  Delete record
- F10  Save record
Discussion: Understanding Form Names – Continued

Position 1:
Identifies the **primary system** owning the form

Position 2:
Identifies the **business process** owning the form

Position 3:
Identifies the **form type**

Position 4-7:
Uniquely identifies the form

<table>
<thead>
<tr>
<th>Position</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Accounting (T)</td>
<td>General Person (P)</td>
</tr>
<tr>
<td></td>
<td>HR/Payroll / Personnel (P)</td>
<td>Application (A)</td>
</tr>
<tr>
<td></td>
<td>Position Control (N)</td>
<td>Budget (B)</td>
</tr>
<tr>
<td></td>
<td>Student (S)</td>
<td>COBRA (C)</td>
</tr>
<tr>
<td></td>
<td>Financial (F)</td>
<td>Benefit/Deductions (D)</td>
</tr>
<tr>
<td></td>
<td>Etc...</td>
<td>Employee (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Electronic Approvals (R)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Etc...</td>
</tr>
<tr>
<td>2</td>
<td>Identification (IDEN)</td>
<td>Application (A)</td>
</tr>
<tr>
<td></td>
<td>Position (POSN)</td>
<td>Inquiry (I)</td>
</tr>
<tr>
<td></td>
<td>Totals (TOT)</td>
<td>Verification/Values table (V)</td>
</tr>
<tr>
<td></td>
<td>Employee (EMPL)</td>
<td>Maintenance (M)</td>
</tr>
<tr>
<td></td>
<td>Etc.</td>
<td>Etc.</td>
</tr>
</tbody>
</table>

Appendix: Quick Reference
Form Name Chart
### Understanding Form Names – Continued

#### Some examples...

<table>
<thead>
<tr>
<th>Position 1:</th>
<th>Example: SAAADMS</th>
<th>Example: SOISBGI</th>
<th>Example: SHQQPNO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifies the primary system owning the form</td>
<td>S=Student</td>
<td>S=Student</td>
<td>S=Student</td>
</tr>
<tr>
<td>Position 2:</td>
<td>A=Admissions</td>
<td>O=Overall</td>
<td>H= Time Reporting/History</td>
</tr>
<tr>
<td>Identifies the business process (module) owning the form</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position 3:</td>
<td>A=Application form</td>
<td>I = Inquiry</td>
<td>Q = Query</td>
</tr>
<tr>
<td>Identifies the type of form</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position 4-7:</td>
<td>ADMS= Admissions</td>
<td>SBGI= Source\Background Institution</td>
<td>QPNO= Qualifying Paper</td>
</tr>
<tr>
<td>Uniquely identifies the form</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Common Forms to Query

<table>
<thead>
<tr>
<th>7-Character Form Name</th>
<th>Form Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAIDEN</td>
<td>Person Search</td>
<td>This form may be used to determine the correct ID number for a person using the query capabilities of the system. The name, ID number, birth date, and name type are displayed.</td>
</tr>
<tr>
<td>TSAAREV</td>
<td>Account Detail</td>
<td>The Account Detail Review Form is used to enter and review charge and payment information about an account. This form presents an online view of each transaction.</td>
</tr>
<tr>
<td>SIAIQRY</td>
<td>Faculty/Advisor Query</td>
<td>The purpose of the Faculty/Advisor Query Form is to enable you to select key pieces of information about faculty members or advisors and to list those people who meet the selection criteria.</td>
</tr>
<tr>
<td>SAAADMS</td>
<td>Admissions Application</td>
<td>This form is used to identify whether a student has multiple admissions applications.</td>
</tr>
<tr>
<td>SOAHSCH</td>
<td>High School Information</td>
<td>This form is used to view information related to a high school student’s academic history.</td>
</tr>
<tr>
<td>SOISBGI</td>
<td>Source/Background Institution</td>
<td>This form displays information about an institution’s type, code, and location.</td>
</tr>
<tr>
<td>SHATERM</td>
<td>Term Sequence Course History</td>
<td>This form displays the student’s current status and GPA information. Scrolling institutional, transfer, and overall GPA totals are displayed on this form each time the term changes.</td>
</tr>
<tr>
<td>SHADEGR</td>
<td>Degree and other Formal Awards</td>
<td>This form is used to review all information pertaining to degrees or other types of awards that the student is seeking, or has been awarded.</td>
</tr>
<tr>
<td>SOAHOLD</td>
<td>Holds</td>
<td>This form is used to display holds a person may have.</td>
</tr>
</tbody>
</table>